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When it comes to time management, sometimes the 
simplest tricks are the best — the ones you learn on the 

fly that save you a few minutes here, a few seconds there. 
 

In this special report, we’ve collected the best of 
Business Management Daily’s advice on how to use 
technology tools you probably already have at your 

disposal to ease your growing workload. 
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Technology: Your best friend and your 
worst enemy  
by Joan Burge 
 
With the development of powerful client management software, word processors 
that seem to do it all, and programs that turn overwhelming amounts of data into 
easy-to-digest graphs, technology seems to be the best thing that’s happened to 
modern working life. 

But pair those innovations with distractingly easy-to-use communication tools, the 
constant call of social media, and access to every game that’s ever been invented at 
the tip of your finger, and you’ll start to see why sometimes the bad outweighs the 
good. 

Starting right now, you should eliminate the use of all personal technology 
platforms throughout your workday. The easiest way to eliminate the bulk of 
personal technology use is to take your cell phone off your desk. Close it in a drawer 
you don’t use frequently throughout the day. Even if your company hasn’t yet 
established cell phone rules, you should set your own boundaries! Avoid personal 
phone calls at work unless there’s an emergency. Leaders are taking note of the 
amount of time their teams are spending on personal technology use. 

Many have found that having access to their work email after-hours keeps 
them looped in and up to date. That’s great; however, you need to have one of 
those courageous conversations with your leader in order to determine when they 
actually expect you to be checking and responding to work emails. You can set a bad 
precedent by responding to one email at 7:00 p.m. but not another. Consistency is 
key! 

Hundreds of emails probably fill your inbox every day. That’s a lot of 
communication to address and a lot of useless distractions to deal with. I suggest 
that when you’re focusing on a big project with a tight deadline, you turn off your 
email notifications. Those constant pop-ups pull you away from the work at hand. 

Use email folders to organize and store important messages. Set up your system 
for storing and flagging critical emails. Become familiar with how to search and 
navigate your email. That way you never have to “dig” through a messy inbox or 
“rummage” through deleted emails to find what you’re looking for. 

https://cms.businessmanagementdaily.com/?p=352853
https://cms.businessmanagementdaily.com/?p=352853
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Finally, I don’t want to leave you with the idea that all technology is bad. It’s 
certainly not. Technology can make your work life better. Invest in and use the 
programs that help you accomplish your goals. For the programs you use every day 
like Microsoft Word and Outlook, use the vast sea of free resources available on the 
internet. The better you understand your tools, the more likely you are to find other 
ways to save time. 

 

Outlook in the time of  
work-from-home  

As many people moved from a centralized office to home offices and other remote 
working spaces, the ease of walking down the hall and having a chat about what was 
on your mind slipped away. Go back even further to a time where when the phone 
rang, someone picked it up. Some offices even still had that as part of their corporate 
culture at the beginning of 2020. Then, everything changed and electronic 
communications of all kinds became key to keeping things flowing in business. 

Many information workers have said that the email load increased, in some cases, 
exponentially within a few months. Consider that while many folks went home to 
work, this didn’t necessarily mean they were doing less. For those who have found 
themselves swimming upstream in their inbox, here are some helpful hints to get 
started sweeping away the mess and setting up systems that will allow Outlook to 
do the repetitive work for you. 

Fast clean-up: Sort, group, delete 
 
1. Sort your mail by sender or subject. 
2. On the View tab, click the Expand/Collapse button and choose Collapse All 
Groups. 
3. Each collapsed group of messages will show you the number of unread items. 
4. Hit the high numbers first. Scan through looking for high numbers of unread 
message counts. 
5. For those that are advertisements, newsletters, social media updates and other 
perhaps nonurgent priority, you can: 

 Delete them – Sends to Deleted Items folder 
 Shift+Delete them – Permanently deletes them 
 Folder them – Use a Read Later folder (fair warning, you may eventually end 

up deleting this one) 

https://cms.businessmanagementdaily.com/?p=355405
https://cms.businessmanagementdaily.com/?p=355405
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Prioritize 

Give yourself visual cues as to what to work on next. To set up a category, right-click 
a message and choose Categorize. Create a new one or rename an existing one to 
something like _TODAY. Using the underscore will help it float to the top anytime 
you right-click and choose Categorize again. Create others like _DO FIRST or _THIS 
WEEK and use a logical color scheme like red, green and yellow. So, if _DO FIRST is 
your red one, when that’s cleared, move on to the _TODAY folder. And, unless you 
want a really bad Friday, work through a few of the _THIS WEEK every day. 

If it requires someone else’s attention, forward it and move it to a folder called 
_DELEGATED. This keeps it out of your inbox. When you have someone’s attention 
on the phone or in chat, you can quickly go to this folder, sort it by name and say, 
“By the way….” 

Now, if you didn’t identify it for action (categories) or delegate it (folder), challenge 
yourself about keeping it. If it represents business communication that doesn’t 
require action, but is needed to maintain adequate information about a customer, 
create a folder for that. Put it in there manually or with a rule. Often these are from 
particular people with particular words in the subject or body. Right-click the 
message, and choose Rules, Create Rule…. The next screen up allows you to specify 
both of these. Then, there’s a space for sending it to a folder. 

To email or not 

The quickest way to stop getting email is to stop sending it. Utilize group-working 
platforms like Teams or Slack to take care of internal quick messages. Manage 
notifications from these platforms so you’re not creating even more email. Meet 
with your team and decide whether it’s best to communicate by email, text, group-
working platform or even… by phone! And breathe. 
 

3 quick tips for Outlook users  
Staying on track with email. It doesn’t take long to start swimming in email at the 
start of a new year. The trick is not losing the important calls to action in the sea of 
other messages. One tool to use when you reply is to set a reminder for both you 
and the recipient. When you reply, click the drop-down arrow in the ribbon for 
follow-up (red flag), choose Add Reminder and notice that you can set one for you 
and one for your recipient. Whoever is the one charged with the task, set that due 
date a day before the due date. 

https://cms.businessmanagementdaily.com/?p=356680
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Goal-minding with Tasks. There are thousands of different ways to record and 
progress toward your goals. If you don’t feel like messing around with a new app, 
use Outlook Tasks. If you plan to track several goals, consider setting up a folder 
under your Tasks folder for each one. Then, using the “Click here to add new Task” 
field at the top of the view, start brainstorming all of the things you’ll need to do to 
accomplish your goal. You can even set recurring tasks to remind you of daily self-
care goals. 

Creating contacts from email. When someone calls you up and says, “Hi! How are 
you?” are you thinking “Hi! Who are you?” There are some people in your network 
with whom you may only be in touch occasionally. When you receive your first 
Outlook email contact from someone, drag it to People to create a contact with that 
email. The contents of the message will be stored in comments. Pop open the contact 
to see how you know them. Bonus: If they have contact data in their signature, you 
can drag it to fields in the contact form. 
 

Two cool Outlook tools quickly 
create reusable email messages  

 
But should you use Quick Steps or Templates? Quick Steps, though it can quickly 
compose a repeatable email, cannot use rich text, graphics or hyperlinks, or 
integrate attachments. For this, you’ll need to use a template. Compose your 
message with everything you’ll need, including attachments. Click on File, Save as 
and save the file as an Outlook template. It will be saved in the right location and be 
accessible from New Items, More Items, Choose Form. Choose User Templates in 
File System as the location. 

 

Keyboard Shortcuts: Outlook  
 
Ctrl+>  
From within a message you are reading, you can instantly navigate to the next message in 
the view with Ctrl+>   You will likely need to access it this way: Ctrl+Shift+. (period). 
 
Ctrl+<  
Ctrl+< has the same functionality as the one above, only navigating to the previous 
messages. You will access this one on the keyboard as Ctrl+Shift+, (comma). 

https://cms.businessmanagementdaily.com/?p=352792
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Ctrl+Enter  
When you are ready to send your message in compose mode, you may use Ctrl+Enter. The 
first time you use it, you will see a dialog box asking you to confirm the setup of this 
shortcut. 
 
Backspace  
If you avoid archiving simply because you think it’s too time consuming, cross that excuse 
off your list. Hitting the Backspace key with a message selected moves it to the Archive 
folder. 
 
Ctrl+Space  
Has copying and pasting created an “overformatted” message with all the colors of the 
rainbow and a varied selection of fonts? Select the text and press Ctrl+Space to clear 
formatting. 
 
Shift+Delete  
When you’re sure you don’t need to keep a message, why put it in the Deleted Items, 
especially when you don’t clear those very often? Warning: Shift+Delete makes it unable to 
be retrieved. 
 
 

Where to find useful how-to learning 
online  
As fast as technology changes, you may find yourself searching for instructional 
videos on how to use new applications and new features on old applications. In fact, 
you may spend just as much time searching and sampling information as you do 
using your tools. Here are some time-savers. 

How to Search 

If you go to your favorite search engine and type in Excel Formulas, you’ll get a ton 
of results. So, the first tip is: Be specific! If you want to know how an IF statement 
works in Excel, type “How does an IF statement work in Excel?” You will likely find 
the answer to your query on the first screen. 

Searching new features like Power Query might yield results from older versions 
that may not be helpful. So, include the version you’re using, too. 

https://cms.businessmanagementdaily.com/?p=356979
https://cms.businessmanagementdaily.com/?p=356979
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Also, click the Tools link under the search criteria field and then the Anytime drop-
down link. Choose results within the last year or even the last month if there has 
been a recent update. 

Now your results are more likely to yield an answer. Know that the provider (e.g., 
Microsoft) will have the most comprehensive information. But other sites might 
explain things better. 

Where to Search 

Searching Google is like searching the ocean for a particular drop of water. You 
might prefer to search YouTube instead. After entering your search criteria and 
launching your search, look at the top left for the Filter button. Click this to narrow 
results by upload date or other criteria. YouTube can be a bit like the wild west. You 
may have to start and stop several videos to decide whether they answer your 
question and whether you can understand the presenter. As well, there are many 
people creating YouTube videos who have a relatively limited understanding of 
what they’re presenting. If you find a solution to your query, check it out on another 
video or two to make sure it’s accurate. 

Building a Library 

Once you find sites or presenters you like, save those links, and subscribe to their 
channels or newsletters. Don’t be afraid to ask questions in the comments sections 
of website blogs or videos. Those of us who post tips out there love talking about 
this stuff! 
 
 

 Did you know that Word can translate 
your documents for you?  
If you receive a document in another language, on the Review tab in the Language 
group, look for the Translate button. You can either choose Translate Document or 
Translate Selection. The Translator task pane will appear on the right and allows 
you to choose a From language and a To language. It will also translate in real time 
while you type if you keep the pane open. Use the Translator only for better 
understanding. To produce a translation that supports a legal agreement, always use 
a professional translator. 

https://cms.businessmanagementdaily.com/?p=355746
https://cms.businessmanagementdaily.com/?p=355746
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 Change styles easily in Word 
If you’ve ever lived through a branding change, you know the heartache of having to 
change pages and pages of content to reflect new colors and fonts. If you use Styles, 
this change is a breeze. Simply change one occurrence of the style—for example, a 
Heading 1. Then, on the Home tab in the Styles gallery, locate the style and right-
click the tile. Then choose Update <style name> to match the selection. Every 
occurrence of that style will now reflect your new fonts and colors. 

 Clean up formatting chaos in Word  
Ever receive content so you can “make it pretty” or “clean it up?” What you received 
may be a heavily, but not necessarily coherently, formatted document. Here are two 
tips. If Styles have been used and just haphazardly changed, select everything 
(Ctrl+A), then press Ctrl+Spacebar. This returns everything to the default formatting 
for that style. A more “scorched earth” approach is to use the Clear Formatting 
button on the Home tab. This sets it all to Normal style. From here, you can start 
over with Styles. 

 Keyboard Shortcuts: Word 
Ctrl+�↓  
Move from one paragraph to the next with Ctrl+↓�. This shortcut is especially useful when 
someone says, “3rd paragraph down on page 10.” (Tip: Try Ctrl+G to go to the right page, 
first.) 
 
Ctrl+→  
If you don’t like squinting just to click in exactly the right spot, try Ctrl+→� from the 
beginning of a line (or the end of the line and use Ctrl+�←) to get to a particular word. 
 
Ctrl+Bkspc  
Most of us know you can select a word and use the Delete key to delete it. But did you know 
that you can use Ctrl+Bkspc to delete the previous one? 
 
Ctrl+Alt+1,2,3  
Heading styles in Word are a powerful and versatile feature. You can easily set selected text 
to Heading 1 style by using the shortcut Ctrl+Alt+1. Ctrl+Alt+2 and Ctrl+Alt+3 will set 
Heading 2 and Heading 3, respectively. Select multiple lines to set all to a particular 
heading style. 
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F5 
Quickly navigate by page, section, line, bookmark, comment or footnote with Go To. The 
default is page, so if you wanted to go to page 100 in your document from wherever you 
were, press F5 and type the page number. Go up or down by clicking Next or Previous. 
 
Ctrl+H 
Launch Find and Replace with Ctrl+H. When the destination of Ctrl+F changed to the search 
field of the Navigation Pane, getting to the Replace tool became a little murky. Ctrl+H gets 
you right where you want to be. 
 
F8  
Using F8 puts Word into Extend mode. Now what? Press F8 again to select the next word, 
again to select up to the next period. Press it one more time to select the whole paragraph. 
No clicking and dragging! 
 
F4 
With F4 you can do whatever you just did, again. It’s kind of the opposite of undo. Let’s say 
you just applied bold formatting for a word of text. Click in the middle of another word, or 
select several words, and press F4 to repeat bolding. 
 
F7 
Apply F7 to spell check the selected word (or ‘from this point forward’). This will reveal 
both spelling and grammar errors. 

 

Use your spacebar to zip through the web 
You’ve probably gotten used to using your mouse to manually scroll down a 
webpage. But the spacebar is not just an essential key for writing, you can also tap it 
to scroll down a webpage with ease. Want to scroll back up? Tap Shift + spacebar. 

 

Screen time helpers  
Screen Time — Downloadable from the Chrome Web Store for your PC. There are 
plenty of apps for the phone, but this one helps keep you focused by limiting your 
time on sites that take you away from your work, such as social media and 
entertainment sites. 

https://cms.businessmanagementdaily.com/?p=355403
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Apple Screen Time — Available for iPhone and iPad settings. If you have an iOS 
small device, you already have this feature! This little tool helps you measure and 
limit the time you spend on your device. Great for families, but it is also great for 
those who are on the screen into the wee hours. 

Flora — Available for iOS, Android and as a Chrome extension for your computer, 
this app gamifies staying off of distracting sites by “growing” or “killing” trees. 
Challenge friends and co-workers to see whose to-do list gets finished first and who 
has grown the most trees! 
 
 

Instead of copy/paste in Excel, try this  
Copying and pasting doesn’t always produce the results we need and can take a lot 
of clicking and dragging. To select data in a column, click on the first cell, then 
Ctrl+Shift+Space before you copy. This will stop before the next blank cell. If you’ve 
typed a formula into the first row and want it on each following row in your list, 
place your cursor over the Autofill handle (tiny black box, lower right of a cell) and 
double-click. Copy it down only one row, with Ctrl+D in the blank cell below. 

 Pin your frequently used Excel 
workbooks for easy access 
If the Excel icon appears in the Windows taskbar, right-click it. Recently opened files 
appear in the pop-up list. Hover over it and you’ll see a thumbtack icon. Click that to 
have it always appear at the top of this list. Just right-click the Excel icon and select 
the pinned file to open it. From Excel, you can do the same, from the File tab. From 
Recent files, hover over the one you want, and you’ll see that thumbtack icon again. 
Click it to have it appear in Pinned files, also viewable from this screen. 

 Comparing Excel lists 
The easiest way to compare two lists of what should be the same things is to do a 
VLookUp on a column that should have a unique value per list. A VLookUp is 
structured as: What do you want to look up? Where do you want to look for it? 
Which column do you want to return? What do you want Excel to do if it can’t find 

https://flora.appfinca.com/
https://cms.businessmanagementdaily.com/?p=356994
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it? So, =VLookUp(What, Where, Which, What if). Start on your source list, and type 
the VLookUp function. Press the tab key to open the parentheses in the formula. 
Click on the cell in the column that is to contain the unique value on the source list, 
followed by a comma. Then select the entire column of data in the target list that is 
supposed to be unique.  

Might be a good idea right there to press the F4 key. This will create “absolute cell 
references” that look like this: $A$1:$A$300, or whatever the last row is. This keeps 
the target range in your formula form automatically incrementing the row numbers 
as you move down your list. In the next field in the VLookUp function dialog box, 
type a 0 in the last field. This tells Excel to find the value exactly, not approximately. 
Press enter and copy it down. 

 Keyboard Shortcuts: Excel 
Ctrl+Enter  

Use Ctrl+Enter to select all the cells in which you want the same thing to appear. You can 
click and drag or use the Ctrl+ or Shift+ arrow keys. Once you’ve selected the cells, type 
your text or formula, then Ctrl+Enter. 

Ctrl+Tab 

Working in more than one workbook? Ctrl+Tab will take you to the next one. Unlike 
Alt+Tab, which takes you to the next window, regardless of the app running, Ctrl+Tab stays 
within Excel. 

Ctrl 

Activate Quick Analysis options by selecting the data you might want to visualize, 
summarize or aggregate. Then, press the Ctrl key to bring up the Quick Analysis options 
box. 

Alt,1  

If you store workbooks in OneDrive or SharePoint, AutoSave will automatically and 
periodically save changes. When it’s more of an inconvenience, turn it off with Alt,1. This 
same shortcut turns it back on. 

Shift+F11 

https://cms.businessmanagementdaily.com/?p=355410
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Easily add a new worksheet with Shift+F11. It inserts it to the left of the active worksheet. 
If you use a Surface or similar device, be sure the Fn key is pressed to use Function keys. 

Ctrl+F1 

Need to see more spreadsheet and less ribbon? Use Ctrl+F1 to hide the ribbon. Need it 
back? Use the same shortcut to reveal it again. 

Ctrl+; 

Need to put today’s date in a cell? Try the Ctrl+; shortcut. Whatever date your computer 
says it is, is the date that will be entered into the cell. Always need the cell to convey the 
current date? Try the TODAY() function. This will create a constant that doesn’t change. 

Ctrl+: 

Someone finally made it easy to enter the current time into a cell. The Ctrl+: shortcut 
(which can also be interpreted as Ctrl+Shift+;) will enter the time in the correct format. 

Ctrl+;,Spc,Ctrl+:  

To enter the current date and time as a constant, in edit mode, use the Ctrl+; shortcut, 
followed by a tap on the spacebar, followed by the Ctrl+Shift+; shortcut. To always have the 
current date and time, use the NOW() function. Be sure to format the cell to show both date 
and time. Otherwise you may only see time. 

 

Time to unplug: Stop feeling like you’re 
always ‘on’  
Technology is increasingly blurring the line between home and office. The ability to 
log into the company system at any hour from one’s own computer or answer 
emails beyond traditional business hours offers a great deal of convenience and 
flexibility. However, it also can lead to the feeling that you’re always “on.” 

Having children and/or a spouse around 24/7 during this crisis further contributes 
to the lack of distinction between professional life and private time. No doubt the 
arrangement has been a godsend for many businesses and educational institutions 
that would have had to cease operations completely without a remote option. 
However, the jumble can prove stressful. 

https://cms.businessmanagementdaily.com/?p=355505
https://cms.businessmanagementdaily.com/?p=355505
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With the odds heavy that many workers will remain virtual for the foreseeable 
future, consider these strategies aimed at helping to disconnect and unwind: 

Give work its own physical space 

Creating a dedicated room (or even just a table) for job-related tasks not only keeps 
your materials at the ready and your weekly report from accidentally ending up in 
your son’s biology folder, it establishes a mindset. Instead of work tools and papers 
creeping into all areas of your home and reminding you of things that still need 
finishing, they stay out of sight and out of mind. 

“In my home, when I close my office door, you would never know that I work from 
home,” says Orlando personal injury lawyer Tina Willis. “The rest of my house looks 
like a home, not an office or work station. I think that helps mentally with separation 
once I finish working each day.” 

Take tech breaks 

Can’t resist the temptation to complete a little bit more or check every incoming 
message regardless of the hour? Consider logging off the computer and turning off 
the phone during certain periods of the day, after a set time in the evening, or on 
weekends. If you wish, set up a reply message notifying the sender when you’ll 
respond, or include your “office hours” in your signature line and voice mail. 

“Because PR is a 24/7 profession, I make a point to completely shut down my 
cellphone and laptop between the hours of 5-7 p.m. (sometimes longer) to give my 
full attention to my family and friends: dinner time, homework, and scheduled social 
activities,” says Mary Ellen Ynes, an independent communications professional 
based in the San Francisco Bay Area. 

Create rituals 

When you went to the office, chances are you had patterns that gave the day 
structure and flow, such as heading through a drive-in for coffee on the way in or 
reading the newspaper on the train ride home. Such habits allow transition between 
work and private time. Look for ways to incorporate similar cues in your present 
situation, perhaps by brewing a pot of tea before sitting down at the computer in the 
morning or walking the dog as the bridge action between the end of work and the 
start of evening relaxation. 

“Change your clothes,” suggests Nate Masterson, HR manager for Maple Holistics. 
“As amazing as it sounds, working from your bed in your pajamas may be good for a 
day or two, but not as a lifestyle choice. You need the physical aspect of it to match 
the mental change you are implementing. Home is home and work is work, even if 
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work happens to be at home. And, contrary-wise, when you are done, change back 
to your hangout-at-home clothes as soon as you can.” 

Make a point of relaxing 

Lastly, be certain to give downtime its due. Give your full attention to people that 
matter and activities that you enjoy during nonwork hours. Carve out time for an 
online exercise class. Do a crossword puzzle without interruption. Cook a fancy 
dinner with your spouse for a home-based date night. Gather the kids for a rousing 
game of Monopoly. Just because you “saw” your family during hours when you’d 
usually be at the office does not mean you actually had quality interaction. 

“When you work from home, it may be difficult to disconnect from your work. But, 
consider this: Time away from work actually helps you become more productive,” 
says Maura Thomas, author of Personal Productivity Secrets. “Breaks aren’t just a 
nicety. You need them to do your best work. Unwinding with friends, family and 
hobbies reduces stress and energizes your brain. But you lose those benefits if you 
spend evenings and weekends wrapping up ‘just one more thing’ for work or 
constantly emailing.” 
 

Use EverNote to track your ideas 
EverNote is an app that sets up a personal space allowing you not only to plan your 
schedule, but jot down information and notes fast, and manage your expenses. Your 
notes can contain photos, files, audio, saved web content, and to-do lists. Evernote is 
a free online service that allows users to upgrade to Premium or Business accounts. 
Find out more at www.evernote.com 

 

Keyboard Shortcuts: PowerPoint  
B 
If your audience gets fidgety or looks confused, sometimes it’s good to bring them back to 
your face and your voice. Press B on your keyboard to black the screen. 
 
N 

http://www.evernote.com/
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Notice the size of the letters on the Page Down key. Notice its location. Not easy to find in a 
pinch. Now look for the N key. Bigger and right at the bottom of your keyboard, almost at 
the center. 
 
 
P 
While it’s not as ideally located as N on the keyboard, the P key is also large and easier to 
find than the Page Up key. Perfect if your clicker goes on the blink. 
 
Ctrl+↑↓ 
If you’ve ever had to use a touchpad mouse, you know the struggles of clicking and 
dragging a slide around a presentation. Ctrl+↑↓ works from the navigation pane. Select a 
slide or a section and move it up or down in the presentation order. 
 
Ctrl+Shift↑↓ 
From the navigation pane, Ctrl+Shift↑↓ moves a slide or section to the very top or very 
bottom of the presentation. It’s great for quickly getting something out of the way, without 
deleting it. Works on multiple slides, too. Ctrl+Click to select slides, and then use this 
shortcut to move them. 
 
Ctrl+S  
In the middle of a presentation, and need to go back to a specific slide? Use Ctrl+S to get the 
menu of slides. Type the slide number indicated to navigate directly there. It even shows 
you the last slide you were on so you can get back quickly. 
 
Ctrl+Shift+Tab 
Easily switch to Outline view with Ctrl+Shift+Tab. While you can do this from the ribbon, 
it’s easier to create your presentation outline and see it transformed into slides in one step. 
 
Alt+Shift+1 
After completing your content in Outline view, get an overall picture of how your 
presentation is organized with Alt+Shift+1. It collapses the outline down to slide titles. 
 
Alt+Shift+↑/↓  
If you need to move a slide up or down in the order, use Alt+Shift+↑/↓ (up or down arrow). 
If your outline is expanded, you may need to select the title and its bullets. 

 

 Keyboard Shortcuts: Windows 10  
Win+B 

https://cms.businessmanagementdaily.com/?p=353613
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Small screens and touchpad mouse pointers can be frustrating when working with items in 
the notification area. Win+B followed by Enter allows you to navigate this area with your 
arrow keys. 
 
 
 
Win+H 
If typing is not your strong suit, voice type with Win+H. Whether you’re in an open Notepad 
file or a cell in Excel, what you say is recorded as text. Say “stop dictating” to get it to stop. 
 
Win+V  
View the list of clipboard items from each time you used Copy or Cut with Win+V. Use 
arrow keys to select and Enter to use it in the open application. 
 
Win+← or →  
Snap window left or right: After snapping, choose any other window. It automatically snaps 
in the other direction. Great for working across multiple Excel workbooks and between 
email and calendar! 
 
Win+D  
This combo will get you back to your desktop, then back to whatever you had open. If 
you’re working on something confidential, it quickly clears your screen. When you have 
privacy again, use the same shortcut to restore then open windows. 
 
Win+U  
Need to change your display settings, turn on the Narrator or make any other settings 
changes? This shortcut brings up all your Windows settings. 

 

G Suite tips & tricks: Timesaving 
changes to make  
So many people adopted Gmail for their personal email accounts and became used 
to working in their Google apps in a very basic way. As organizations began to adopt 
G Suite, Google’s business platform, few people explored what more was possible on 
their new business productivity platforms. Here are three simple tips to make you 
more productive. 

https://cms.businessmanagementdaily.com/?p=352367
https://cms.businessmanagementdaily.com/?p=352367
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World Clock 

Do you interact with co-workers, customers and suppliers from around the world? 
Add the World Clock to your calendar. With this handy tool, you can click a meeting 
on your calendar and check the time in multiple time zones. To add it: 

1. Click the settings gear at the top right of your calendar and choose Settings. 

2. Under General, select World Clock. 

3. Turn the World Clock on. 

4. Add the time zones you wish to display. 

Now, when you click on an event in your calendar, look at the left navigation pane, 
below the small calendar, to see the other time zones reflected. You’ll even see a sun 
or a moon to let you know whether the meeting will be a daytime or nighttime one 
for folks in that time zone. 

Templates for multiple signatures 

Do you need multiple signatures for your multiple roles? You can use templates to 
meet this particular need. To create your templates: 

1. Compose a blank email and add the signature, including any logos or links. 

2. In the lower right corner of the compose dialog, click the vertical ellipses. 

3. Select Templates, then Save draft as template. 

4. Name it and click Save draft as the new template (or save over an existing one). 

To use an alternate signature: 

1. Compose a new email message. 

2. In the lower right corner of the compose dialog, click the vertical ellipses. 

3. Under Insert Template, choose yours. 

This feature is also useful for new messages and responses you send all the time that 
are relatively the same. 
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Create to-do lists from email 

Most of us get our calls to action via email. Whether it’s a to-do item for our team, an 
event for which we’d like to register or some research we need to do, an email can 
trigger the task and provide background for getting it done. To create these to-do 
items: 

1. From the open message, click the ellipses on the right of the toolbar above the 
message. 

2. Select Add to Tasks. 

3. You can stop here, click the pencil icon to move it to a specific list or edit the task 
and add: 

 a. Details. 

 b. Subtasks. 

 c. Date/time. 

4. When you’re done with the item, you can close the panel by clicking the X in the 
upper right corner. To access it again, click the Tasks icon (blue circle with a check 
mark). 

 

 

Use Gmail’s Smart Replies to improve 
response shorthand 
Smart Replies are a function in Gmail or G Suite-based email accounts. When you 
enable this function, Smart Replies will predict what you want to write in response 
to an email in your inbox. It’s a great way to dash off routine messages you’d 
otherwise have to type out, saving yourself ten or twenty seconds per reply. 
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 Keyboard Shortcuts: Google Docs  
Ctrl+Shift+C  
Keep track of how many words you’re generating with Ctrl+Shift+C. You get the word count 
as well as the number of pages, characters and characters not including spaces. 
 
Ctrl+Shift+S  
Switch to voice typing mode with Ctrl+Shift+S. Whether you need to work without a 
keyboard in a small space or are mitigating stress on hands/wrists, voice typing is a great 
alternative. 
 
Ctrl+\  
Did you just open a document where the formatting isn’t in line with corporate standards? 
Start over by selecting the text and using Ctrl+\ to clear all the formatting, but keep the 
text. 

 

 Keyboard Shortcuts: Google Sheets  
Ctrl+;   
Use Ctrl+; to enter today’s date into a worksheet cell in Sheets. The date is entered in the 
default format set in Google location settings. These are serial number dates that can be 
used in date calculations. 
 
Ctrl+:  
If you’re tracking time, you can use Ctrl+: to input the current time in the default time 
format matching your Google settings. You can do math with these to determine how long 
something took. 
 
Ctrl+Shift+3  
Sometimes when you do math with a date, the date format will shift back to just a number. 
Ctrl+Shift+3 will set it right. 

 

https://cms.businessmanagementdaily.com/?p=352030
https://cms.businessmanagementdaily.com/?p=350300

